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Release Date: 2013-04-17 

 
 
ETABS 2013 is a major and comprehensive upgrade from ETABS v9.7.4, covering all aspects of modeling, analysis, 
design, and external interfacing to create a powerful and productive tool for building design. Because of the integrated 
nature of this upgrade, most enhancements are included in the following summary. A few specific enhancements will 
be listed at the end, followed by a list of incidents resolved. 

Changes from v9.7.4 (Released 2011-12-20) 

Major Enhancements 

Modeling 

• Model explorer for easy access to all program capabilities 

• Non-modal forms for easy access to select, edit, assign and display 

• Create models by converting AutoCAD Architectural plan to 3D ETABS objects 

• Create models by tracing over AutoCAD plans  

• Ability to add 2D/3D models from templates 

• Live preview of changes while editing or drafting  

• Explicit modeling of curved beams, curved floor edges and curved walls 

• Tracing of building perimeter for quick draw of floor plates 

• Zoom and rotation during model creation 

• Create shearwall and elevator cores parametrically 

• Enhanced editing and selection capabilities 

• Intelligent snaps for easy model creation 

• Introducing multi-tower concepts with tower dependent stories and grids 

• Linear and nonlinear support properties for point, line, and area objects 

• Area load set definitions for load assignments 

• All input/output in user defined mixed units 

Analysis 

• 64 bit advanced SAPFire analysis engine for increased problem size and solution speed 

• New advanced Sparse Solver 

• New multi-threaded solver for multi-CPU, multi-core systems  

• Analysis recognizes and uses 64 bit processing for enhanced performance 

• Model AliveTM feature for instantly seeing the effects of model revision 

• Enhanced meshing capability with more user control 

• Range combination for enveloping pattern loads 

• Construction sequencing allowing changes of members, loads and sections 

• Time dependent concrete age effects, creep and shrinkage 

• Geometric modification – shape finding for specified final geometry 

• Nonlinear layered shell element for shear wall performance based design 

• Nonlinear element to model triple pendulum base isolators 

• Nonlinear element for multi-linear plasticity for modeling soil supports 

• Automated nonlinear fiber hinge model for frame elements 
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• Buckling analysis for any applied load from any stressed condition 

• Linear and nonlinear direct integration time history analysis  

• Enhanced section cuts – results for wall, slab or diaphragm design  

• Generalized displacement definitions for deformation measures 

Design 

• Automated static lateral seismic loads implemented for codes listed below 

• Automated static lateral wind loads implemented for codes listed below 

• Response spectrum functions implemented for codes listed below 

• Auto-permutation of directions and eccentricities for static wind and seismic loads  

• Updated generation of lateral notional loads for design  

• Live load reduction factors implemented for codes listed below 

• Enhanced design output 

• Updated Steel frame design including seismic for codes listed below 

• Special considerations for EBF and BRB 

• Updated concrete frame design including seismic for codes listed below 

• Updated composite beam design for codes listed below 

• Added composite column design for codes listed below 

• Updated shear wall design including seismic for codes listed below 

• Added masonry shear wall design based on ACI 530-11 

• Updated steel joist design based on SJI 2010 

• Wall reinforcement design optimization 

• Curved shear wall design  

• Drift optimization for steel and concrete frame structures 

• Drift optimization for shearwall structures 

• Added steel connections design including base plates for AISC 360-10 

Graphical Display  

• Increased number of view windows 

• Ray tracing, textures, lights and shadows for true rendering  

• DirectX view window with fly through 

• Display of forces acting on a diaphragm 

• Vector direction plots of maximum forces/stresses in slabs and walls  

• Story load, shear and moment diagrams over building height 

• Print graphics using user specified drawing scale  

Output  

• All input, output and design viewable in table format 

• Easy access to corresponding tables from model explorer 

• Table display, including filters and selection 

• Automated generation of standard reports 

• Fully customizable report generation  

• Report includes tabular and graphical output 

• Named displays and user text can be added to reports 

• Report viewable on screen 

• Report can create .docx file 

Detailing 

• Creation of schematic construction drawings for concrete and steel structures  

• Framing plans and schedules for steel frames 

• Framing plans and schedules for composite floors 
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• Reinforcing schedules for concrete beams and columns 

• Reinforcing details for concrete shear wall elevations and cross-sections 

• Customizable detailing rules  

• Customizable drawing sheets with multiple views 

• Automated bill of quantities 

• Print or export to AutoCAD  

External Interfacing 

• ETABS Open API for custom programming and interfacing 

• Import/export of analytical and physical model using IFC 2x2, 2X3, 4  

• Import/export model from/to Revit 2011, 2012 and 2013 

• Import/export model from/to AutoCAD 2011, 2012 and 2013  

• Export graphics to pdf, dxf, bmp, jpeg, giff, png formats  

Documentation 

• Enhanced online/offline help 

• New user’s manuals  

• Updated analysis manual  

• New tutorials and Watch and Learn movies  

• New design manuals 

• New verification manual 

List of Implemented Design Codes 

• Static lateral seismic load codes: 
o ASCE 7-10 
o AS/NZS 1170 2002 
o GB50011-2010 
o Eurocode 8 2004 
o IS 1893 2002 
o Italian NTC 2008 
o NBCC 2010 
o Turkish EDP 2007 
o NZS 1170 2004 
o BOCA 96 
o ASCE 7-02 
o ASCE 7-05 
o NBCC 95 
o NBCC 2005 
o NEHRP 97 
o UBC 94 
o UBC 97 
o UBC 97 Isolated 
 

• Static lateral wind loads codes: 

o ASCE 7-10 
o AS/NZS 1170.2:2002 
o GB50009-2012 
o Eurocode 1 2005 
o Indian IS875:1987 
o Italian NTC 2008 
o NBCC 2010 
o Turkish TS 498-97 
o ASCE 7-88 
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o ASCE 7-95 
o ASCE 7-02 
o ASCE 7-05 
o BOCA96 
o BS 6399-95 
o NBCC 95 
o NBCC 2005 
o Mexican 
o UBC 94 
o UBC 97 
 

• Response spectrum functions codes: 

o AS1170-2007 
o ASCE 7-02 
o ASCE 7-05 
o ASCE 7-10 
o BOCA 96 
o GB50011-2010 
o Eurocode 8-2004 
o IS 1893:2002 
o Italian NTC 2008 
o Italian3274 
o NBCC 2005 
o NBCC 2010 
o NBCC95 
o NEHRP97 
o NZS1170-2004 
o NZS 4203 
o Turkish EDP 2007 
o UBC 94 
o UBC 97 

 

• Live load reduction factors codes: 

o ASCE 7-95 
o ASCE 7-05 
o ASCE 7-10 
o AS/NZ 1170.1-2002 
o GB 50009-2012 
o Eurocode 1991:2002 
o Hong Kong COP 2011 
o Indian IS 875-1987 
o NBCC95 
o NBCC2005 
o NBCC2010 
o UBC97 
o User Parameters (per Section 1607.5, UBC 1997) 
o User Defined Curves (By Tributary Area) 
o User Defined (By Stories Supported) 
 

• Steel frame design codes: 

o AISC 360-10 
o AISC 360-05 
o AISC LRFD 93 
o AISC ASD 89 
o AS 4100-1998 
o BS 5950-2000 
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o CSA S16-09 
o Eurocode 3-2005 
o IS 800:2007 
o Italian NTC 2008 
o NZS 3404:1997 
o GB50017-2003 (Chinese version) 

 

• Concrete frame design codes: 

o ACI 318-11  
o ACI 318-08 
o AS 3600-09 
o BS 8110-97 
o CSA A23.3-04 
o Eurocode 2-2004 
o Hong Kong CP 2004 
o IS 456:2000 
o Italian NTC 2008 
o KCI-1999 
o Mexican RCDF 2004 
o NZS 3101:2006 
o Singapore CP 65:99 
o TS 500-2000 
o GB50010-2010 (Chinese version) 

 

• Composite beam design codes: 

o AISC 360-10 
o AISC 360-05 
o BS 5950-1990 
o CSA S16-09 
o Eurocode 4-2004  
o GB50017-2003 (Chinese version) 

 

• Composite column design codes: 

o AISC 360-10 
o JGJ3-2010, CECS159:2004, JGJ138-2001  (Chinese version) 

 

• Shear wall design codes: 
o ACI 318-11  
o ACI 318-08 
o AS 3600-09 
o BS 8110-97 
o CSA A23.3-04 
o Eurocode 2-2004 
o Hong Kong CP 2004 
o IS 456:2000 
o Mexican RCDF 2004 
o NZS 3101:2006 
o Singapore CP 65:99 
o TS 500-2000 
o GB50010-2010 (Chinese version) 
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Other Enhancements 

License and Installation 
Enhancements Implemented 

* Incident Description 

 38377 Licensing has been upgraded to the version 8.5 of RMS. Version 8.5 or later of License Manager is 
required to serve network licenses. All licenses are now web-activated, requiring an internet 
connection to activate, deactivate, or renew a license. Users can move a license from one system to 
another provided they have administrative rights on both systems. The trial license is no longer 
available, but a separate Evaluation version of the product will be provided after the initial release 
of ETABS 2013. 

Modeling 
Minor Enhancements 

* Incident Description 

 51374 SidePlate® moment connections have been updated based on the latest design criteria provided by 
SidePlate Systems. The new options now include a tag for Wind or Seismic design to specify 
default SidePlate length. 

Loading 
Minor Enhancements 

* Incident Description 

 51370 A new design load type “Construction” has been added for defining load combinations used in 
composite beam design. Load cases of this design type are now included automatically in the "AISC 
36005" and "AISC 360-10" design load combination for pre-composite action as 1.2*Dead 
+1.6*Construction. Previously this load combination was defined as 1.6*Dead +1.6*(0.2)*Live. 

 51371 A new design load type “Seismic (Drift)” has been added. The Seismic (Drift) load does not enforce 
the upper limit for time period for computing base shear as specified in most of the loading codes. 
This option now allows the seismic loading to be considered for serviceability. 

Frame Design 
Minor Enhancements 

* Incident Description 

 13830 For steel frame design using the "AISC 360-05" code, previously the D/C ratio was not available in 
"Stress Check Output" table when KL/r > 4.0*Sqr(E/fy). Now the "Stress Check Output" table will 
show the D/C ratio whenever possible along with the Error Messages when section fails. 

 39500 Concrete frame design using the "Eurocode 2-2004" code has been enhanced to now check the 
beam/column (B/C) capacity ratio for DCM_MRF for seismic design of concrete frames. Previously 
the B/C capacity ratio was only being checked for DCH_MRF concrete frames. Note that for 
Eurocode 3-2005 steel frame design, the B/C capacity ratio was being checked for both DCM_MRF 
and DCH_MRF steel frames. 

 51373 Steel frame design using the "AISC 360-10" and "AISC 360-05" codes has been enhanced by 
providing a tag in Design Preferences to include/exclude stiffness reduction for the Direct Analysis 
Method. This option can be used to exclude steel-frame stiffness reduction for drift cases. Note that 
this preference applies to the model as a whole and affects both strength and deflection design. 
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Results Display and Output 
Minor Enhancements 

* Incident Description 

 27124 A database table including base reaction results has been added to the available analysis results 
tables. 

 34390 An enhancement was implemented to report story forces for sequential construction cases at both 
the top and bottom of each story instead of averaging the top and bottom values. 

 14342 The printed auto-seismic information for IBC 2006 has been enhanced to include additional 
information, comparable to IBC 2003. 

 



ETABS 2013 v13.0.0 2013-04-17 Page 8 

Incidents Resolved 
 
Following are the Incidents Resolved in this release. Most incidents do not affect most users. Incidents marked with 
an asterisk (*) in the first column of the tables below are more significant and are included in the ReadMe file. 

User Interface and Display 
Incidents Resolved 

* Incident Description 

 13580 An incident was resolved in which the default dimension lines did not update when the gridline 
ordinates were changed. This was a graphical issue and did not affect analysis results. 

 13802 An incident was resolved in which the Area Diagram form used to display area contours did not 
update the story level if it was not closed between right-clicking on areas on different levels. This 
did not affect results. 

 14597 An incident was resolved in which all content is not always displayed/refreshed when manipulating 
windows. 

 14647 An incident was resolved to correct a spelling mistake on the Story Data form. 
 17956 An incident was resolved in which it was possible to insert a new story with a blank name. This did 

not affect results. 
 18856 An incident was resolved in which modifying the name of an auto-wind or auto-seismic load pattern 

would reset the load parameters to defaults, even if the design code was not changed. The results 
matched the parameters present in the form after they were reset to default. Now the values are not 
reset to default when changing the name of the load pattern unless the design code is also changed. 

 19520 An incident was resolved in which a runtime error was generated when defining a time history 
function with a large numerical value, 1E10 or larger. This did not affect results. 

 23449 An incident was resolved in which the time period targets for steel frame design were being cleared 
when the steel frame design was run. 

 24261 An incident was resolved in which a runtime error was sometimes generated when using the Tab 
key to navigate through the data on the Edit Grid Data form. This would happen if there were more 
than 15 X or Y-grids defined. 

 26452 An incident was resolved in which a runtime error would sometimes occur after right clicking on a 
frame member to show the bending moment diagram for an enveloped load combination, and then 
changing the units using the units dropdown in the lower right corner of the main window. This did 
not affect the results. It is no longer possible to change units while viewing the right-click diagram 
for frame forces and moments. The units settings are now fully customizable and it is rarely 
necessary to change them. 

 27605 
30509 

An incident was resolved in which a runtime error was generated when overwriting the starting 
section for an auto-select list, if no section was chosen before clicking OK on the form. This did not 
affect results. 

 30514 An incident was resolved in which a runtime error could occur when defining a joist section on a 
system that has regional settings that use a comma (,) as the decimal separator. 

 34096 An incident was resolved in which a runtime error would sometimes occur when using the reshape 
tool to explicitly set the dimensions. This occurred if the mouse was moved while editing the 
dimensions and it came across a snap point. 

 34704 An incident was resolved in which unchecking the "Include P-delta" option and then checking it 
would reset the scale factor for DEAD load cases to 1.0. The analysis results would correspond with 
the scale factors shown in the form. 

 42058 An incident was resolved in which a runtime error was generated when renaming a diaphragm 
definition if both forms were not closed using the OK button before trying to modify the diaphragm 
definition for a second time. This did not affect results. 
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Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 15047 An incident was resolved in which the database units were always used when drawing door and 
window openings, irrespective of the current display units. This did not affect results. 

 15250 An incident was resolved in which the Delta Z value was ignored when trying to move a joint that 
had a z-coordinate of 0. This did not affect results. 

 24280 An incident was resolved in which projected loads on areas were not displayed when using the 
Display > Show Loads command. This was a display issue only and did not affect results. 

 25271 An incident was resolved in which drawing area objects in elevation view would orient the area 
local axes differently depending on whether the area object was drawn on a single story or drawn 
across multiple stories. This did not affect the accuracy of the results, but could affect the 
interpretation of the results with respect to the area local axes. 

 28970 An incident was resolved in which turning on the object fill would cause the program to terminate 
for certain models. 

 36439 An incident was resolved where the command Edit > Divide Lines > Break at Intersections with 
Visible Grid Lines did not always work. This command is now called Edit > Edit Frames > Divide 
Frames > Break at Intersections with Visible Grid Lines. 

 37350 An incident was resolved where the Edit > Replicate command did not function correctly when 
replicating to a story with a negative Z elevation. The selected objects would instead be replicated 
to a different story. 

 38815 An incident was resolved in which an exception (runtime error) was generated for certain models 
when performing a window selection. This did not affect results. 

 39305 An incident has been resolved where the Draw Areas command did not work in an elevation view. 
The new Draw Floor/Wall commands work in plan, elevation, and in 3D (with appropriate 
restrictions). 

 45265 An incident was resolved in which the story labels were not being displayed in elevation view when 
a gridline was defined as only being visible over a select range of stories. 

Modeling 
Incidents Resolved 

* Incident Description 

 12804 An incident was resolved in which duplicate wall objects were generated when using the Edit > 
Undo command to undo subdividing the wall for openings. 

 13889 An incident was resolved in which story data was being included when using the "Choose .EDB" 
model initialization option to start a new model. This option is now called "Use Settings from a 
Model File". 

 19293 An incident was resolved in which the HSS3.5x0.188 pipe section property in the AISC13 property 
libraries had an incorrect wall thickness of 0.0188in instead of 0.188in. 

 29660 An incident was resolved in which a runtime error was sometimes generated when modifying point 
coordinates using the right-click point information form. This did not affect analysis results. 

 36590 An incident was resolved in which a circular concrete frame section property would revert to a 
column design type even if specified as a beam (M3 design only) design type. 

 43144 An incident was resolved where using the mirror option when replicating beam and column frame 
members sometimes resulted in the generated members being classified incorrectly as braces. This 
in turn could change the automatic end releases, since these do not apply to braces. Analysis and 
design results agreed with the model as replicated. 

 43822 An incident was resolved in which user-defined gridlines specified to exist over a specific story 
range were being displayed to one story below the specified story range. This did not affect results. 
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* Incident Description 

 49275 An incident was resolved where the automatic end offsets calculated for a column object were not 
correct in the special case where (1) the top of the beam framing into the column was below the 
story level, and (2) the column was divided into multiple objects. In this case the end offsets for a 
column object above the beam were being calculated from the beam below when they should not 
be. The end offsets for each object could be seen in the model, and the effect on results was small. 

Section Designer 
Incidents Resolved 

* Incident Description 

 15755 An incident was resolved in which a runtime error would occur when using the Section Designer 
and specifying a rebar size as NONE, then right-clicking on it. This was a user interface issue only 
and did not affect results. 

 44339 An incident was resolved in which the section properties calculated for a Section Designer section 
were not correct in the unusual case where an opening was present that touched the edge of a solid 
circle and for which the opening was partially overlapping the inside and the outside of the circle. In 
this case the opening was being ignored and the section properties were calculated as if the opening 
was not present. 

 46041 An incident was resolved for concrete frame design in which the interaction surface could not be 
computed for certain large or narrow wall-type sections modeled as frames. When this occured the 
error was obvious. 

Loading 
Incidents Resolved 

* Incident Description 

 15169 
17574 
42905 

An incident was resolved in which the automatic open structure wind loading using the ASCE 7-05 
code was not being applied. This could be easily detected by reviewing the deformed shape of the 
load case. 

 23533 
49795 

An incident was resolved where applied parapet pressure was incorrect for ASCE 7-02 and ASCE 
7-05 codes when Gust factor was less than 1.0. The value of GCpn was being calculated instead as 
GGCpn. 

 37466 
41479 

An incident was resolved in which distributed frame loads assigned in the frame local 1, 2, and 3 
directions were not correctly accounted for when computing mass source from loads. The loads 
were being converted to mass as if they were applied in the gravity direction, with positive loads 
adding mass and negative loads subtracting mass (but not less than zero). This did not affect the 
mass computed from frame distributed loads assigned in the global directions. Mass computed from 
concentrated frame loads or load applied to any other objects were not affected. This error only 
affected the mass computed from frame distributed loads, not the frame distributed loads 
themselves. 

  41397 An incident was resolved where open-structure wind load was not being applied to some frame 
objects for which such loading had been specified. The behavior was inconsistent, however for each 
object either the correct loading was applied or no loading at all. 

 44422 An incident was resolved where the damping specified for response-spectrum functions was not 
being used for analysis. Now, the response spectrum function is adjusted at each modal period using 
Newmark's velocity formula from the damping specified for the function to the summed damping in 
the model from the response-spectrum load case, material damping, and link-object damping. 

 45653 An incident was resolved where the incorrect values for Fa and Fv were displayed when defining a 
seismic lateral load for the NBCC 2005 code. This was a display issue only for the form. The 
correct values were being used to calculate the load, and the results were not affected. 

 48382 An incident has been resolved where uniform temperature loading assigned to a frame object is not 
applied when the option to include joint temperatures has been specified for the same frame object 
in the same load pattern. Only the joint temperature load was being applied in such a case. 
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Analysis 
Incidents Resolved 

* Incident Description 

 23958 An incident was resolved where the distribution of frame moments near a concentrated frame span 
load was not correct for nonlinear static analysis. The total load applied was correct and overall 
equilibrium was correct. However, the moment diagram within the loaded element and distribution 
of moments near the element could differ between linear static and nonlinear static analysis for a 
linear structure. This error was only for concentrated span loads. Distributed span loads and 
concentrated loads on joints and areas were not affected. 

 27270 An incident was resolved where, for certain models, error messages were generated (regarding 
frame results) when performing concrete frame design with load combinations that included a 
construction-sequence load case for dead load. When this occurred, the design results were all zero 
and the error was obvious. 

 32794 An incident was resolved where the analysis became unresponsive and produced no results for a 
particular model file. No results were available. 

 42003 An incident has been resolved where the analysis was being performed for the live-load reduction 
factors even when these were not needed. 

 45828 An incident was resolved where the link elements internally created to model panel-zones were not 
being included in the groups used for staged-construction analysis. This resulted in beams and 
columns being disconnected for staged-construction load cases, and the error was obvious. 

Frame Design 
Incidents Resolved 

* Incident Description 

 13974 An incident was resolved for steel frame design using the "BS 5950-2000" code in which single 
and double-angle sections would be classified as Class 4 when their width-to-thickness ratio was 
exactly equal to 24*epsilon. The code specifies the limit for Class 3 as 24*epsilon, therefore they 
should have been classified as Class 3. This would only affect sections that resulted in a width-to-
thickness ratio of exactly 24, which was rare. Classifying the section as Class 4 was slightly 
conservative. 

 16744 An incident was resolved for steel frame design according to the "CSA-S16-01" code in which the 
design output reported the incorrect section class for the right-click deflection output. This was 
only a reporting issue and did not affect results. The reporting of the section class for deflection 
design output has been removed because it is not relevant. 

 19509 An incident was resolved for steel frame design according to the AISC LRFD-93 code in which an 
error message was generated when the input value of Fy was smaller than the code-mandated 
value of Fr (10ksi for rolled shapes and 16.5 ksi for welded shapes). No results were reported in 
this case and the error was obvious. 

 19527 An incident was resolved for steel frame design using the "Chinese 2010" code where the strength 
check was always using the gross area rather than the net area regardless of whether the design 
overwrite "Net Area to Total Area Ratio" was specified or not. 

 24739 An incident was resolved in which the steel frame design optimization using lateral-displacement 
targets would sometimes not satisfy the specified targets even though larger sections were 
available in the auto-select list. 

 29529 An incident was resolved in which the lateral bracing points used for steel frame design were not 
being initialized when a new model was created, but instead were using the values from the 
previous model if a previous model had been open in the same ETABS session. However, if a new 
model was created as the first model in a given ETABS session, then the initialization was correct. 
Design results were consistent with the lateral bracing points as initialized or subsequently 
assigned by the user, and were evident in the model.  
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* Incident Description 

 29862 The classification of tee sections for steel frame design using the "Eurocode 3-2005" code has 
been enhanced to remove a minor conservatism in the classification of the web outstand. The error 
message for Class 4 sections was also modified to simply report a Class 4 section without a code 
clause. 

 31442 An incident has been resolved where the minimum torsional reinforcement requirement as given in 
AS3600-2001 section AS 8.2.8 was not accounting for unit conversion. Models with default 
database units in N-mm produced the correct results. For other units, conservative results were 
generally produced when torsional reinforcement was governed by Asv,min. 

 31545 An incident was resolved for composite beam design using the Canadian "CISC 95" code in which 
the reaction factor specified in the design overwrites was not accounted for in the composite-beam 
design-reaction output. The affected code "CISC 95" has been replaced by the newer code "CSA 
S16-09" for which the incident is resolved. 

 33319 An incident was resolved for concrete frame design using Eurocode 2-2004 that addressed two 
issues: (1) The normalized axial force limit of 0.55 was enforced for DCM column design, 
whereas Eurocode 8-2004 allows the use of 0.65 for this factor. The value of 0.55 is still used for 
DCH column design. These limits are only applicable when seismic load is present. (2) The "Axial 
Compression Ratio" was computed and reported for the characteristic concrete strength (fck) 
instead of design concrete strength (fcd). In rare cases, this may produce unconservative results. 
Users should rerun the design for older models to verify the acceptability of design results. 

 34651 An incident was resolved for steel frame design using the "Eurocode 3-2005" code in which the 
"GammaOV" design overwrite was not retained after setting it in the overwrites form, and hence 
had no effect. The results matched the settings. 

* 35291 An incident was resolved for concrete frame design using the "ACI 318-08" code in which the 
column design for minor-direction shear was not being checked for capacity shear in Special 
Moment Frames, but was instead reporting the results for major-direction shear. The column was 
being designed correctly for major-direction shear. This error could be unconservative. 

* 36554 An incident was resolved for continuity-plate design at the beam-column joints of steel frames in 
which the reported continuity-plate areas for certain cases could be incorrect. This occurred when 
a continuity plate was needed at the beam-column joint and the beam-flange force was large. The 
required area of the continuity plate that was reported could be unconservative (too small) in 
certain rare cases when the continuity plate design was governed by continuity plate buckling. 
However, any design that uses the thickness of the beam flange for the continuity plate will be 
sufficient. This affected the following codes: “AISC 360-05/IBC2006”, “Eurocode 3-2005”, 
"CAN/CSA-S16-01" (no longer supported), and “CSA-S16-09”. All other codes are unaffected by 
this issue. Users should review previous designs by these codes where continuity plates were 
required and the areas of the plates actually used were less than that of the corresponding beam 
flanges. The previous implementation was consistent with the documentation, and the 
documentation has also been corrected. 

 37634 An incident has been resolved for steel frame design in variants of AISC codes in which Q was un-
conservatively being taken as 1.0 in the case where the web of the I, Box, and Channel sections is 
slender in axial mode but not slender in flexural mode. This has been changed so that now the Q 
factor is being calculated correctly for this case. Factor Q was always being calculated correctly 
for sections where web is slender in flexural mode. The affected codes are "AISC360-05", "AISC-
LRFD93" and "AISC-ASD89". Similar changes have also been made for the "CSA S16-09" code. 
(Previous codes that were also affected but are no longer supported include: "AISC-ASD01", 
"AISC-LRFD99", "UBC97-ASD", and "UBC97-LRFD"). This error rarely affected results. 

 38903 An incident has been resolved for concrete frame design using the Indian "IS 456:2000" code 
where, for certain specific model files, an error message was generated during design indicating 
that there was an error calculating the Q factors. The reported Q factors were zero and the design 
was performed for these values. 

 40074 An incident was resolved for steel frame design using the "AISC 360-05" code where the shear 
capacity was not being multiplied by the Phi factor when Pr/Py was less than or equal to 0.15 for 
EBF (eccentrically braced frame) link beams. This affected versions 9.0.0 to 9.7.4. The error was 
obvious because the capacity being used was reported. 
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* Incident Description 

 40565 
42041 

An incident was resolved for concrete frame design using the Eurocode 2-2004 code where the 
design detail results were incorrectly reporting a load combination containing seismic load as 
being non-seismic when the axial force in the member was tensile. In this case, the reporting of 
compression capacity check was omitted. However, the compression capacity is not relevant in 
such a case. This was a reporting issue only. All design checks were correct, and no results were 
affected. 

 41129 An incident was resolved for composite beam design using the "AISC 360-05" code in which the 
compactness was not being calculated correctly for the case of a coverplate attached to the bottom 
flange of the beam. Beams without cover plates were designed correctly. If cover plates were 
present, the program was unnecessarily showing a message that the section is slender, which could 
be over-conservative. All other design results were correct. 

 41931 An incident has been resolved for concrete frame design using the Eurocode 2-2004 code where 
the Design Overwrites form provided the following extraneous parameters that were not being 
used: Moment coefficients Cm Major and Cm Minor, NonSway Moment Factors Dns Major and 
Dns Minor, and Sway Moment Factors Ds Major and Ds Minor. These parameters were not 
documented and were not being used for design. No results were affected. These parameters have 
now been removed. 

 42274 An incident was resolved in which joint shear checks were unnecessarily being performed for 
intermediate moment frames. This affected all versions of the ACI 318 concrete frame design 
code. The effect was conservative. 

 43502 An incident was resolved in which the unbraced length factors reported on the right click design 
detail sheets for steel frame design were not correct if the value(s) had been overwritten by the 
user and the member had end offsets assigned explicitly or determined from connectivity. This did 
not affect the design results. 

 43806 An incident was resolved for composite beam design using the "AISC 360-05" code in which the 
resistance factor for shear, phi_v, was taken as 0.9 even when the size of the section met the limits 
of clause G2.1(a) which allows phi_v to be taken as 1.0 in the case of composite action. This 
resulted in an over-conservative value of the shear capacity being used. 

 48052 An incident was resolved for concrete frame design where, on rare occasions, an over-stressed 
(OS) condition was reported when the design moment was very close to but not exactly equal to 
zero. This could occur due to a numerical tolerance problem. This was a rare problem and was 
over-conservative when it occurred. 

 48586 An incident was resolved error for steel frame design using codes "AISC 360-05" and "AISC-
LRFD99" (no longer supported) where all T-sections were being classified as Seismically Not 
Compact even when that was not true. The error was obvious and conservative. 

 49532 An incident has been resolved for steel frame design where the adjustment factor for moment 
capacity due to the lateral-torsional-buckling limit state could be inaccurate for cases where the 
end offsets at the two ends of the frame object were not exactly the same. This factor is called Cb 
in AISC codes, Alpha_m in Australian codes, n factor in BS codes, Omega2 in CSA codes, and C1 
in Euro, Italian and Indian codes. This error was of a round-off/truncation type and primarily 
affected the case where one of the end offsets was set to zero and the other to a large value relative 
to the length of the member. This most commonly could affect columns where the end offset at the 
bottom is typically zero. Results were usually unaffected for beams and other members where the 
end offsets are similar at the two ends. When the error did occur, it was small and led to over-
conservative results. Results were unaffected if user-specified lateral bracing was specified using 
the command Design > Steel Frame Design > Lateral Bracing. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 13104 An incident was resolved for shear wall design where the D/C ratio was not being displayed 
graphically for Piers when the checking option was used. The results were available in the design 
details. 
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* Incident Description 

 25524 An incident was resolved for shear wall design where, in very rare cases, multiple wall objects at a 
given story level making up a single pier were not properly merged into a single object for design 
purposes. When this happened, the shape was treated as triangular rather than rectangular, and only 
a single layer of reinforcement was generated instead of two. This caused flexural failure in shear 
wall due to lack of significant flexural capacity. When this occurred, the error was obvious and 
conservative. 

 27915 An incident was resolved in which the PMM interaction surface was not able to be computed for 
certain section designer wall-pier sections. 

 46247 An incident was resolved for shear wall design using the "BS8110-97" code for simplified C and T 
design where the default material reduction factors gamma_c and gamma_s were always being used 
even when different values had been specified by the user in the Design Preferences.  

Results Display and Output 
Incidents Resolved 

* Incident Description 

 17170 An incident was resolved in which a runtime error was sometimes generated when defining time-
history traces for section cuts and trying to modify/show the time-history function from within the 
time history traces form. This was a user interface error only and did not affect results. This feature 
is now called plot functions and has been substantially revised. 

 19323 An incident was resolved in which enveloped printed analysis results would include sequential case 
results, even when the case was not selected for output. This was a display issue only and did not 
affect individual case results. 

 21908 An incident was resolved in which the load combinations table would repeat data when there were 
15 or more load combinations defined in a model. This did not affect results. 

 24288 An incident was resolved in which the coordinates defining the shear wall legs in the shear wall 
design output were sometimes missing a negative sign. This was a reporting issue only and did not 
affect results. 

 27972 An incident was resolved for concrete frame design for the "Chinese 2010" code where the 
summary results incorrectly provided the rebar design strength instead of design moment envelope. 

 31443 An incident was resolved in which the AS and NZS auto-seismic load input was not available 
through the File > Print Tables > Input command. This was a limitation of the program and did not 
affect results. 

 31549 An incident was resolved in which the number of decimal places shown on results displays did not 
change after modifying the Options > Preferences > Output Decimals settings. This did not affect 
results. The number of decimal places for each type of input and output quantity is now controlled 
by the comprehensive settings for units. 

 33301 An incident was resolved in which drawn section cuts would sometimes mistakenly categorize area 
objects as ramps, such that toggling on/off the ramps or walls on the section cut results form would 
result in incorrect values. The totals with both walls and ramps on were correct. 

 36789 An incident was resolved in which the File > Print Tables command sometimes presented incorrect 
summed values of the joint reactions table for the moment values. The correct values were available 
using the Display > Show Tables command. The sum of the Joint Reactions are now presented in a 
separate table called Base Reactions. 

 40946 An incident was resolved where joint reactions (and spring forces) did not include the effects of 
response-spectrum eccentricity. The reported reactions were those of the response-spectrum case 
without the eccentricity. All other response quantities (displacements, forces, stresses, story shears, 
etc.) correctly included the effect of specified eccentricity. 

 41127 An incident was resolved where the plotting of spandrel forces for a very short spandrel sometimes 
showed zero force when non-zero values were present. Plotting of shell stresses and section-cut 
forces showed the correct values. 

 41681 An incident was resolved in which the shear wall design output database table used the column 
heading "End Spacing" instead of "Edge Spacing" for edge bars. This was a terminology issue only 
and did not affect results. 
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* Incident Description 

 43157 An incident was resolved in which the details of the auto seismic calculation per the NZS code were 
not being included in the text output. This output has been enhanced in ETABS 2013 and is now 
available for all codes. 

 44605 An incident was resolved in which the Chinese 2010 pier shear wall design output was not available 
in tabular format or for printing. The results were not affected. 

 45354 An incident was resolved in which the story drifts obtained via the File > Print Tables command 
were missing data for certain models and/or load cases. This was a results display issue only. 
Complete results were available using the Display > Show Tables command. 

 45797 An incident was resolved in which the option to show time-history traces for a single mode was not 
working, but was instead showing the same superposed results for all modes as when this option 
was not used. This option has been removed from ETABS 2013 as it is rarely used and does not 
apply to most plot functions. 

 47291 An incident was resolved in which a runtime error was generated in some cases when using the 
Draw > Section Cut option while displaying frame shear forces. The error would occur before the 
section cut results were reported. 

Database Tables 
Incidents Resolved 

* Incident Description 

 18557 
35361 

An incident was resolved in which the load combinations table would repeat data when there were 
15 or more load combinations defined in a model. This did not affect results. 

 23043 An incident was resolved in which negative-valued insertion point distances were reported as blank 
in the database tables. This was a reporting issue only and did not affect results. 

 27023 An incident was resolved in which the Force Assignments to Points table was blank for certain 
models. This did not affect results. 

 27694 An incident was resolved in which exporting the auto wind load tables for the IS 875 code to a 
Microsoft Access (*.MDB) file would generate an error and result in a blank table. This did not 
affect model results. 

 32400 An incident was resolved in which data copied from some database tables would not paste properly 
into Microsoft Excel. This did not affect results. Now a direct export to Excel is available as well as 
copy/paste operations. 

 35256 An incident was resolved in which the frame and area temperature load database tables were blank 
for some models. This did not affect results. 

 39793 An incident was resolved in which exporting the auto wind load tables for code IS 875 to a 
Microsoft Access *.mdb file would generate an error and result in a blank table. This did not affect 
model results. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 18460 An incident was resolved in which the *.WRN file is deleted when the analysis is run, if it is present 
in the model folder. 

 20320 An incident was resolved in which steel orthotropic materials imported from an ETABS text file 
(.E2K) had their modulus of elasticity values reset to default values. The results from analysis 
would match these reset material properties. 

 26661 An incident was resolved in which multistory spandrels were not exported to the *.e2k text file. The 
multistory spandrel assignment was properly saved in the regular *.edb model file. 

 30718 An incident was resolved where the assignments of tension/compression limits to frame objects was 
not exported to the model text file (.E2K or .$ET), causing these assignments to be lost when 
importing the model back from the text file. Results were consistent with the model as imported. 
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* Incident Description 

 31785 An incident was resolved where the cross-sectional area of Section Designer sections imported from 
the text file (*.E2K, *.$ET) was not always correct unless the user opened and saved the imported 
property in Section Designer. The error was obvious because the area being used was shown in the 
tables. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 14773 An incident was resolved for the export to IFC of models represented by the IFC Structural Analysis 
Domain where member end releases were not being exported and member cross-section dimensions 
were sometimes exported in the wrong units. This did not affect the export of models represented by 
the IFC Building Physical Model. 

 24269 
40418 

An incident was resolved in which importing STAAD (*.std) files would generate a runtime error if 
there were trailing blank characters at the end of certain data lines, cause the import to fail. No 
results were available. 

 24502 An incident was resolved where attempting to export certain models to SAFE using either of the 
options "Export Floor Loads and Loads from Above" or "Export Floor Loads plus Column and Wall 
Distortions" would generate a runtime error or cause the software to become unresponsive. When 
this error occurred, the model was not exported. No results were affected. 

 38743 
40144 

An incident has been resolved where an exception (runtime error) occurred during the import of 
certain STAAD (*.std) data files. 

 41185 An incident was resolved in which the SDNF export was not working when the model had not yet 
been analyzed. 

 42744 An incident was resolved for the export to SAFE where beam forces and moments that were 
specified in the frame local-axis directions were not being exporting. However, beam forces and 
moments that were specified in the global directions were being exported. 

 44809 An incident was resolved in which exporting a model to CIS/2 would generate an error when the 
"Loads from elements only" option was used. This resulted in no CIS/2 file being written. It did not 
affect numerical results. 

 46161 An incident was resolved in which errors are generated when trying to export the auto-wind load 
data for Indian code to a MS Access (*.mdb) file. 

 47085 An incident was resolved in which the export of a floor to SAFE omitted some walls in certain 
models. 

 52137 An incident has been resolved where program was generating a runtime error when a specific 
ETABS model containing wind load was exported to Revit Structure. 

Documentation 
Incidents Resolved 

* Incident Description 

 15951 An incident was resolved in which the help topic "Align Joints/Frames/Edges" referred to a 
"specified maximum move allowed" value for the "Align Joints to Nearest Frame or Edge" option. 
This setting does not exist and the help topic has been modified accordingly. 

 33294 An incident was resolved in which the steel frame design manual for the "AISC 360-05" indicated 
that there was a design overwrite for Omega0, but this option wasn't actually available in the 
program. This design overwrite has now been added to be consistent with the documentation. 

 36249 An incident was resolved in which the IS 456-2000 concrete frame manual indicates that the partial 
safety factor for concrete, gamma_c, defaults to 1.15. The manual has been corrected to indicate 
that the default value actually used is 1.5. There is no change to the behavior of the software. 

 50681 A documentation error was resolved where the formula for the lateral torsional buckling 
modification factor in the steel frame design manual for the Indian "IS:800-1998" code did not show 
the actual Eurocode formula that is being used for design. This was a documentation error only. 
Results were not affected. 


